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Introduction
Thank you for purchasing the Multi-Converter!
The Multi-Converter is a device that enables users of Brother,
Babylock, Bernina Deco or Simplicity, Husqvarna, Viking, Janome
8000/9000, Elna, New Home, Kenmore, Bernina Artista, Fairyland,
Pfaff, and Singer embroidery machines to read and write embroidery cards.
The device has totally four card slots. Each slot can read and write
cards from the following embroidery machines:
Slot A : Singer (XL-100, XL-1000)
Slot B : Pfaff, Bernina Artista, Fairyland
Slot C : Janome, Elna, New Home, Kenmore
Slot D : Brother, Bernina Deco, Babylock, Husqvarna, Viking
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Embroidery Cards
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There are basically three types of embroidery cards:
1. Pre-programmed ROM cards
2. Pre-programmed flash cards
3. Blank cards
Either an embroidery machine or a card reader can read ROM cards.
Restrictions might apply as a result of copyrights where a card can
only be read by an embroidery machine.
Flash cards can be read as if they were ROM cards; the same restrictions can apply as for ROM cards. The main difference between
flash cards and ROM cards is that flash cards can be written to with
a card-writer that can write flash cards. As far as the embroidery
machines are concerned both types of cards are the same.
Brother manufactures two types of blank cards: Brother blank cards
and flash blank cards. Brother blank cards contain a fixed ROM area
for administrative purposes and a user area that can be written
by a card writer; flash blank cards are 100% writable. Some of the
space on flash blank cards is used to store the administrative data
mentioned earlier. Other manufacturers use 100% writable cards.
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The maximum capacity of any embroidery card is 1 Megabyte
(1048576) bytes. Pre-programmed Brother Cards come in 2 capacities: 1
Megabyte or 512 Kilobyte (524288) bytes. The Brother blank card
has a fixed ROM area of 512 Kilobyte and a user area of 128 Kilobyte.
Pre-programmed Viking cards are normally 512 Kilobyte. The Viking
blank card is a 256Kilobyte card. Flash blank cards come in sizes of 512
Kilobyte and 1 Megabyte.
The number of designs that can be stored on an embroidery card
is primarily dependent on the total number of stitches in the designs
and a bit on the number of colors used in the designs. There is also
a little bit of administrative overhead. As a rule of thumb one can say
that a Brother blank card can hold approximately 55.000 stitches, a 512
Kilobyte card can hold approximately 200.000 stitches and a 1 Megabyte card can hold 450.000 stitches. For Viking blank cards the figures
are 130.000 for a 256 Kilobyte card and 260.000 for a 512 Kilobyte card.
The Multi-Converter supports the reading of embroidery cards that can
be read by the Brother Card writer module and the writing
of Brother blank cards as well as most flash cards. The Multi-Converter
currently supports cards built using 28F010 (Brother blank cards),
28F020 (Viking blank cards), 29F040, 29F400 (Brother blank cards),
28F004 (Brother blank cards), 29F080, 28F008SA, 49F008, 29F800,
and 29C040, which is used by Pfaff and Bernina Artista.
Flash cards containing patterns can be reused for writing. Designs
already present on the cards can be read using the Multi-Converter
utility and stored on your computer in a safe place. After that you
can write a new collection of designs to the flash card. Later on
the original designs can be restored to the embroidery card using
the Multi-Converter utility.
The Multi-Converter also provides information about embroidery cards
including the chip type used to build the card.
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Card Capacity

Cards that work with the MultiConverter
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Embroidery cards normally contain only a single chip.
Embroidery cards come in 4 different form factors. The form factor
of the card needs to match your embroidery machine. Cards with
a non matching form factor will not fit in the embroidery machine.
The different form factors are for:
> Brother, Babylock, Bernina Deco, Simplicity, Viking, Husqvarna
> Pfaff, Artista
> Janome, Elna, New Home, Kenmore
> Singer
You might notice that some 512K cards appear in multiple lists.
Cards that have equal chip types are actually the same. For example: 512K cards can be used for both Brother and Viking embroidery
machines. This is independent of the chiptype.
Brother, Babylock, Bernina Deco, Simplicity
Manufacturer

Product No

Title

Card Type

Card
Size

Vikant

Ultimate Card

Blank card

AMD Am29F080B

1M

Brother

XA0154-001

Blank card

Intel 28F010

128K

Brother

XA0154-001

Blank card

AMD Am28F010

128K

Brother

XA0154-001

Blank card

Intel E28F004

512K

Brother

XC0401-001

Blank card

Macronix
MX29F400T/B

512K

Viking

4124176-01

Blank card

Intel 28F020

256K

Great Notions

BHMC-FLASH

Blank card

SGS M29F040B

512K
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MCARD-BV

Blank card

Centennial

x

Blank card

Hyundai HY29F040

512K

Brother

#43

Victorian

Fujitsu MBM29F800T

1M

Brother

#44

Lace

Fujitsu MBM29F400T

512K

Brother

#45

Fancy Work

Fujitsu MBM29F400T

512K

Brother

#46

Australian Animals

Fujitsu MBM29F400T

512K

Brother

#47

Butterfly

Fujitsu MBM29F400T

512K

Brother

#48

Australian Flowers

Fujitsu MBM29F400T

512K

Brother

#49

Folk Art

Macronix
MX29F400T/B

512K

Brother

#50

Fairy and Floral

Fujitsu MBM29F800T

1M

Brother

#51

Paper Dolls

Fujitsu MBM29F800T

1M

Brother

#52

Bears

Macronix
MX29F400T/B

512K

Brother

#53

Scenes

Fujitsu MBM29F800T

1M

Brother

#54

Tea Time

Fujitsu MBM29F800T

1M

Brother

#55

Gardening

Fujitsu MBM29F800T

1M

Brother

#56

Asian

Fujitsu MBM29F800T

1M

Brother

#57

Christmas Time

Macronix
MX29F400T/B

512K

Brother

#58

Quilting Designs

Macronix
MX29F400T/B

512K

Brother

#60

Summertime Fun

Fujitsu MBM29F800T

1M

Brother

#61

Blouse Embellishment

Fujitsu MBM29F800T

1M

Brother

#62

Zodiacs

Macronix
MX29F400T/B

512K

Babylock

BLEC-C1

Tapestry

SGS M29F040B

512K

Babylock

BLEC-C2

Sewing

SGS M29F040B

512K

Babylock

BLEC-C3

Cross-Stitch

SGS M29F040B

512K
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OESD
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Babylock

BLEC-C4

Fall Holidays

SGS M29F040B

512K

Babylock

BLEC-C5

Cutwork

SGS M29F040B

512K

Babylock

BLEC-C6

Noah’s Ark

SGS M29F040B

512K

Babylock

BLEC-C7

Victorian Tapestry

Hyundai HY29F080

1M

Babylock

BLEC-C8

Religious Crosses

SGS M29F040B

512K

Babylock

BLEC-C9

Home Decorating

AMD Am29F080B

1M

Babylock

BLEC-C10

Betty Boop

Intel 28F008SA

1M

Babylock

BLEC-C11

Butterflies and Flowers

Intel 28F008SA

1M

Babylock

BLEC-C12

Blondie

SGS M29F040B

512K

Babylock

BLEC-C13

Back To School

Intel 28F008SA

1M

Babylock

BLEC-C14

Art Deco

Atmel AT49F008

1M

Babylock

BLEC-C15

Christmas Collection

Atmel AT49F008

1M

Babylock

BLEC-C16

Mike Abrams Collection I

Atmel AT49F008

1M

Babylock

BLEC-C18

Christmas 2001

Atmel AT49F040

512K

Babylock

BLEC-C19

Elegant Baby Designs

Atmel AT49F040

512K

Babylock

BLEC-C22

Mice & More

Atmel AT49F008AT

1M

Brother Boutique

331023

Nautical 2

AMD Am29F040B

512K

Brother Boutique

331035

Large Designs 1

AMD Am29F040B

512K

Brother Boutique

331036

Large Designs 2

AMD Am29F040B

512K

Great Notions

BMC-101

Floral Collection I

SGS M29F040B

512K

Great Notions

BMC-102

Christmas Collection I

SGS M29F040B

512K

Great Notions

BMC-104

Birds & Butterflies Collection I

SGS M29F040B

512K

Great Notions

BMC-105

Fall Holidays Collection I

SGS M29F040B

512K

Great Notions

BMC-106

Childrens Collection I

SGS M29F040B

512K

Great Notions

BMC-108

Cross Stitch Collection I

SGS M29F040B

512K

Great Notions

BMC-109

Cutwork Collection I

SGS M29F040B

512K
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BMC-110

Country Garden Collection I

SGS M29F040B

512K

Great Notions

BMC-113

Halloween

Atmel AT49F008AT

1M

Great Notions

BMC-115

American Christmas

Atmel AT49F040

512K

Great Notions

BMC-CT1

Cherished Teddies Collection I

AMD Am29F080B

1M

Great Notions

BMC-CT2

Cherished Teddies Collection II

Intel 28F008SA

1M

Great Notions

BMC-CT2

Cherished Teddies Collection II

Atmel AT49F008

1M

Great Notions

BMC-CT3

Cherished Teddies Collection III

AMD Am29F080B

1M

Great Notions

BMC-DS1

Dream Sicles I

SGS M29F040B

512K

Great Notions

BMC-DS2

Dream Sicles II

SGS M29F040B

512K

Great Notions

BMC-EB1

Quilting Labels Collection I

Atmel AT49F040

512K

Great Notions

BMC-GF1

Garfield Collection I

SGS M29F040B

512K

Great Notions

BMC-SS1

Bert & Ernie Collection I

SGS M29F040B

512K

Great Notions

BMC-SS2

Big Bird Collection I

Hyundai HY29F040

512K

Great Notions

BMC-SS3

Elmo Collection I

SGS M29F040B

512K

Great Notions

BMC-SS4

Elmo in Gouchland Collection I

SGS M29F040B

512K

Great Notions

BMC-SS5

Sesame Street Christmas
Collection I

Atmel AT49F008

1M

Great Notions

BMC-DJ1

Deborah Jones

SGS M29F040B

512K

Great Notions

BMC-DM1

Dennis the Menace Collection I

SGS M29F040B

512K

Great Notions

BMC-SB1

Sandra Betzina

SGS M29F040B

512K

Great Notions

BMC-MH1

The Morehead Collection I

Hyundai HY29F040A

512K

Great Notions

BMC-MP1

Martha Pullen

SGS M29F040B

512K

Great Notions

BMC-NZ2

Nancy Zieman II

SGS M29F040B

512K

Great Notions

BMC-NZ4

Nancy Zieman IV

Hyundai HY29F040A

512K

Great Notions

BMC-DG1

Degee

SGS M29F040B

512K

Great Notions

BMC-BAR1

Barney

SGS M29F040B

512K

Great Notions

BMC-POP1

Popeye Collection I

SGS M29F040B

512K

Great Notions

BMC-MP3

Martha Pullen 3

Atmel AT49F040

512K
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Great Notions
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Great Notions

BNMC143

Everyday with Mary Engelbreit

Atmel AT49F008

1M

Great Notions

BNMC145

Debbie Mumm’s Baby Oh Baby

Atmel AT49F008

1M

Bernina

123

Precious Moments

Intel 28F008SA

1M

Bernina

126

Lace & Romantic Designs

Intel 28F008SA

1M

OESD

B1001

Butterflies

Intel 28F008SA

1M

OESD

B1002

Birdhouses

Intel 28F008SA

1M

OESD

B1003

Cuddly Critters

Intel 28F008SA

1M

OESD

B1005

Always a Holiday

Intel 28F008SA

1M

OESD

B1006

Down Home Christmas

Intel 28F008SA

1M

OESD

B1007

Butterflies

Atmel AT49F008

1M

OESD

11109

Carousel

Atmel AT49F008

1M

Dakota

970059

AMD Am29F040B

512K

Simplicity

SMC1

Sampler card

Hyundai HY29F040

512K

Walmart

XC1815-001

Animals

Fujitsu MBM29F400T

512K

Walmart

XC1819-001

Christmas

Fujitsu MBM29F400T

512K

Walmart

XC1704-001

Floral 1

Fujitsu MBM29F400T

512K

Walmart

XC1708-001

Lace

Fujitsu MBM29F400T

512K

White 3300

103

Butterflies

SGS M29F040B

512K

White 3300

105

Teddy Bears

SGS M29F040B

512K
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Manufacturer

Product No

Title

Card Type

Card
Size

Vikant

Ultimate
Card

Blank card

AMD Am29F080B

1M

Viking

4124176-01

Blank card

Intel 28F020

256K

Brother

XC0401-001

Blank card

Macronix MX29F400T/B

512K

Great Notions

BHMC-FLASH

Blank card

SGS M29F040B

512K

OESD

MCARD-BV

blank

Centennial

x

Blank card

Hyundai HY29F040

512K

Great Notions

HMC-BB1

Big Bird Collection I

Hyundai HY29F040A

512K

Great Notions

HMC-CT1

Cherished Teddies Collection I

Hyundai HY29F040A

512K

Great Notions

HMC-CT3

Cherished Teddies Collection III

Hyundai HY29F040A

512K

Great Notions

HMC-DJ1

Debra Jones

Hyundai HY29F040A

512K

Great Notions

HMC-DS1

Dream Sicles 1

SGS M29F040B

512K

Great Notions

HMC-NZ1

Nancy Zieman 1

SGS M29F040B

512K

Great Notions

HMC-NZ1

Nancy Zieman 1

Hyundai HY29F040A

512K

Great Notions

HMC-MP1

Martha Pullen

SGS M29F040B

512K

White 3300

103

Butterflies

SGS M29F040B

512K

White 3300

105

Teddy Bears

SGS M29F040B

512K
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Viking, Husqvarna

Pfaff

Manufacturer

Product No
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Pfaff

Title

Card Type

Card
Size

Creative card

Atmel AT29C010A

128K

Pfaff

#16

Floral and Script Monograms

Fujitsu MBM29F040

512K

Pfaff

#19

Pets

Fujitsu MBM29F040

512K

Pfaff

#24

ABC

Fujitsu MBM29F040

512K

Pfaff

#28

Scattered Flowers

Fujitsu MBM29F040

512K

Pfaff

#29

Quilt

Intel 28F020

256K

Pfaff

#39

Wild animals

Fujitsu MBM29F040

512K

Pfaff

#41

Martha Pullen

Fujitsu MBM29F040

512K

Pfaff

#43

Coat of arms

Fujitsu MBM29F040

512K

Pfaff

#44

Country life

Fujitsu MBM29F040

512K

Pfaff

#45

Birds

Fujitsu MBM29F040

512K

Pfaff

#48

Pattern combinations

Fujitsu MBM29F040

512K

Pfaff

#49

Big Hoop Pattern Combinations

Fujitsu MBM29F040

512K

Pfaff

#50

Quilt

Intel 28F020

256K

Pfaff

#53

Patterns Combinations

Fujitsu MBM29F040

512K

Pfaff

#55

Australia

Fujitsu MBM29F040

512K

Pfaff

#57

Applique

Fujitsu MBM29F040

512K

Pfaff

#62

Comics

Fujitsu MBM29F040

512K

Pfaff

#63

Asia

Fujitsu MBM29F040

512K

Pfaff

#67

Combinations Christmas

Fujitsu MBM29F040

512K

Pfaff

#71

Monograms 1

Fujitsu MBM29F040

512K

Pfaff

CF

7560

Fujitsu MBM29F040

512K

Pfaff

PP

Philip Pepper Special Card

Fujitsu MBM29F040

512K
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#300

Creative card

Fujitsu MBM29F016A

2M

Pfaff

#300

Fantasy

Fujitsu MBM29F017A

2M

Pfaff

#305

Asia

Fujitsu MBM29F080A

1M

Pfaff

#308

Ethno

Fujitsu MBM29F080A

1M

Pfaff

#309

Flowers

Fujitsu MBM29F080A

1M

Pfaff

#310

Lace

Fujitsu MBM29F040

512K

Pfaff

#312

Hardanger

Fujitsu MBM29F080A

1M

Great Notions

PFMC-CT

Cherised Teddies

SGS M29F040B

512K

Pfaff

Creative card

Atmel AT29C040

512K

Pfaff

Creative card

SRAM

512K

Bernina

Personal Design Card

Atmel AT29C040A

512K

SSHS

PA29C040

blank

Atmel AT29C040A

512K

SSHS

PA29F040

blank

SGS M29F040B

512K

Great Notions

AMPC-FLASH

blank

SGS M29F040B

512K

OESD

MCARD-AP

blank

Centennial
SSHS

512K

blank

SRAM

512K

P29F032

blank

AMD Am29F032

4M

Product No

Title

Card Type

Card Size

Personal Design Card

AtmelAT29C040A

512K

blank

AtmelAT29C040A

512K

Bernina Artista
Manufacturer
Bernina
SSHS

PA29C040
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Pfaff

Rewritable cards:
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Manufacturer

Product No

Title

Card Type

Card Size

Great Notions

AMPC-FLASH

blank

SGS M29F040B

512K

OESD

MCARD-AP

blank

Bernina

524

Debbie Mumm Everyday

SGS M29F080A

1M

Bernina

527

Sue Box Beautiful Borders

AtmelAT49F008AT

1M

Bernina

535

Christmas

AtmelAT49F008AT

1M

Bernina

541

Leslie Beck Holiday

AtmelAT49F008AT

1M

Bernina

547

Current Critters

AtmelAT49F008AT

1M

Bernina

548

Carol Endres Christmas

AtmelAT49F008AT

1M

Bernina

550

Crewel Embroidery

AtmelAT49F008AT

1M

Bernina

558

Debbie Mumm’s Quilt Shop

AtmelAT49F008AT

1M

OESD

A1015

Animal Instincts

AtmelAT49F008AT

1M

512K

Janome, Elna, New Home, Kenmore
Manufacturer

Product No

Title

Card Type

Card Size

Janome

241801105

Scan ‘n Sew II

Fujitsu MBM29F040

512K

Scan ‘n Sew I

ROM+RAM

128K

Janome
Kenmore

241801105

Card for Scanner

Fujitsu MBM29F040

512K

Great Notions

ENHMC-FLASH

blank

Hyundai HY29F040A

512K

OESD

MCARD-J

blank

512K
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Singer
Product No

Title

Card Type

Card Size

Singer

387166

Original Design Card

Fujitsu MBM29F040

512K

Manufacturer

Product No

Title

Card Type

Card Size

Great Notions

SGMC-FLASH

blank

AMD Am29F040B

512K

Multi-Converter English 1-01

Manufacturer

Rewritable cards:
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The Multi-Converter is designed with two primary goals.
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1. develop a device that can write more designs to a card than the
current card writer modules can.
2. develop a device for users that don’t design, but only stitch
out designs.
More designs
The Multi-Converter can write to flash embroidery cards that have
a larger capacity. As a result of this the user can write more designs
to an embroidery card.
Read/write only
Various users do not digitize themselves, but buy ready-made
patterns from pattern vendors or alternatively download free
designs from the worldwide web. Those users only need
the Multi-Converter and its utility in order to write designs
to an embroidery card.
Additional applications
Large designs can be split by packages into designs that will fit
on Brother blank cards. The advantage here is that multiple of those
split designs can be stored on a single flash card.
Pattern designers can create their own collections and distribute
them on cards instead of floppies or email or other media.
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The Multi-Converter package contains the following items:
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> One (1) “Multi-Converter” Device
> One (1) USB Cable
> One (1) Installation CD with the Multi-Converter utility
> One (1) Quick Start Guide for the “Multi-Converter”

“Multi-Converter”
device (1 pc)

USB cable
(1 pc)

The CD also contains an extensive manual in PDF format.
Acrobat Reader must be installed on your PC in order to view
and print this file.

If you want to connect the Multi-Converter device to a Serial COM Port, you
have to purchase a serial cable and an AC
Adaptor. These accessories can be found
at any electronics or computer store and
their specifications are:
1.Serial cable.
This is standard serial 9-pin male/9-pin
female cable. Due to high baudrate
used we recommend length to be limited to max 3 meters. (Baudrate used on
serial RS232 is 115.2 kb)
2. AC adaptor.
Specification for this device is:
Input: according to local mains voltage
Output: DC 9 Volt nominal 250 mA
minimum output current.
Connector: Round DC plug 2.1 mm. +
centre - outside.
Typical devices are 9 VDC 300mA.

In case not, please install it from the CD

USB connection does not require an AC
adaptor as the device is powered directly
from the PC.

Installation CD
(1 CD-ROM)

Quick Start Guide
(1 pc)
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System Requirements
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> PC with PENTIUM II or faster processor
> Windows OS: Windows 95/98/2000/ME/XP
> 64MB of RAM (128MB or more recommended)
> CD-ROM Drive
> 10MB (or more recommended) of available hard-disk space
for installation
> Color standard (640x480 pixels, 16 colors) VGA adapter
connected with a color VGA monitor (1024x768 pixels; 65.000
colors recommended)
> Microsoft compatible mouse
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Setting up the device

1. Unpack the Multi-Converter package and locate the device.
2. Locate the USB cable from the package. Connect the cable to the
device and then to a free USB port, with the computer turned off.
3.Turn on the computer.
4.Check now whether one of the leds is on. The Multi-Converter will
do a power on self-test. The results of this test are displayed on
the leds. The first led will flash and then the other will follow.
5. When Windows start, insert the Installation CD.
6.The Autoplay Wizard will automatically prompt you to proceed
to the software installation. Click on “Cancel” to continue with
the installation of the USB drivers.
7. The device will be detected automatically and the “Add New
Hardware Wizard” will come up. Click “Next”.
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Please follow the steps described below in order to set up
the device:

If you do not have any free USB ports
on your computer, you can use a USB hub,
a device that connects to a USB port
and makes more USB ports available.
This device can be bought from any electronic or computer store.

8. Select “Install the hardware that I manually select from the list
(Advanced)” and press “Next”.

Multi-Converter English 1-01

9. On the next screen that comes up click on the “Have Disk…” button.
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10. By browsing the CD, select the folder D:\USBDRIVERS where the
USB drivers are located.

11. When the Microsoft message comes up, select “Continue Anyway”.
12. The procedure ends and the device is installed.
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Installing the Multi-Converter
Utility
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Please follow the steps described below in order to install
the Multi-Converter Utility:
1. Turn on the computer
2. Insert the Installation CD included in the package
3. The Installation Dialog will come up automatically. If it does
not start, go to My Computer -> CD Rom Drive (where the CD
is mounted, e.g. D:) and double-click on setup.exe
4. Follow the steps as instructed by the setup screens
5. A shortcut icon will be set on your desktop, from where
you can start the Multi-Converter Utility

The Multi-Converter is fully compatible
with all popular Windows platforms,
Windows 95 ®, Windows 98 ®, Windows
2000 ®, Windows ME ® and Windows ΧP ®.
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The Multi-Converter requires little to no configuration. The configuration that might be required is the Serial Port configuration.
The initial configuration of Multi-Converter is COM4 and USB.
If for whatever reason COM4 is not available for Multi-Converter,
the configuration dialogue will be displayed and you can configure
both Serial Port and interface to match your configuration.
Only usable ports will be displayed. USB users can find out
to which Serial Port the Multi-Converter is connected by starting
the Multi-Converter utility, going to Settings -> Hardware, pressing
the “Search” button and in the new window that appears press
the “Auto” button. This will automatically detect the Serial Port
and Port Type that the Multi-Converter device is connected.

 | Installation Guide | Configuration
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Starting the MultiConverter utility
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When you start the Multi-Converter Utility, you enter the basic
menu of the utility.

If you do not have the Multi-Converter
device connected on your PC, or you did
not configure its port settings properly,
the “Erase Card” and the “Card Information” buttons will be deactivated.
The basic menu is the one shown
in the screen below.
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This menu contains all the basic functions of the Multi-Converter:
Read Card, Write Card, Erase Card, Card Information, Settings
and Exit.
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These functions are also included in the File Menu

The Help menu contains the options shown here.
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Read Card
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The Read Card option enables you to read sewing files from any
embroidery card. These can be saved into other media files like
a hard disk, a floppy disk, a SmartMedia card etc.
The main window of the Read Card option is shown below.

This window consists of the main toolbar, the file catalog,
the directory & info box, the preview box, the Read and the Close
buttons, and the status bar.

| User’s Guide | Read Card 
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Main Toolbar

The main toolbar contains all the functions related to reading
designs from an embroidery card.
Properties: It shows information on the selected design,
and it enables the user to save it in different formats
Graphics: This option opens up a new window where all
the designs included in the catalog are shown as images
Catalog: The Catalog option creates a catalog of all the
designs included in the directory, in an HTML format
Print: It prints a screenshot of the screen shown currently
Bitmaps: This option opens up a new dialog with an overview
of the bitmaps of the designs included in the directory (it only
works for PES files)
Clip: This option makes a clip of the catalog of files for
Notepad
Transfer: By pressing “Transfer”, the selected design file is
opened automatically by the predefined program (e.g. Stitch
& Sew)
Browse: The Browse option enables the user to set the
directory where the files will be saved (default directory
C:\My Designs), and a prefix name for the files
Read Card: It reads the files from inserted card, and it saves
them in the defined directory, using the defined prefix name
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You can only insert one card at a time
to the Multi-Converter. Otherwise the
device will not be able to read the files
from any card.

File Catalog
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The file catalog shows all the files that exist in the selected
directory. Note that if you define a directory that already contains
files, in order to read and save the files from a card, all these files will
appear on the catalog box above.
Directory & Info Box

This box shows the directory in which the files will be saved,
the type of embroidery files that will be read, the prefix name
and the type of card inserted.
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Preview Box

The preview box shows a preview of the selected design file.
The image is in black & white, just enough to give you a clue of what
the design is about.

Read and Close Buttons

Although the “Read Card” and the “Close” options are already
available on the toolbar and on the top right corner of the window,
these buttons exist for reasons of ease of use.

Status Bar

The status bar shows the progress in the process of reading an embroidery card. This bar shows information only when card reading
is in progress.
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How to read designs from an embroidery card
1. With the device plugged into your computer, start the MultiConverter utility
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2. Insert the card that you want to read from, into the corresponding slot. Each slot reads specific types of embroidery cards:
Slot A : Singer (XL-100, XL-1000)
Slot B : Pfaff, Bernina Artista, Fairyland
Slot C : Janome, Elna, New Home, Kenmore
Slot D : Brother, Bernina Deco, Babylock, Husqvarna, Viking
3. Press the “Read Card” button from the main menu

4. When the “Read Card” box appears, press “Browse”
and set
the directory where you want the design files to be saved from
the card, and also the prefix name that you want and press “Save”

| User’s Guide | Read Card 

5. Then, press the “Read Card” button

from the low right corner

6. When the reading process ends, all the design files from
the card will be saved in the selected directory, where they
can be accessed anytime

7. If you want to transfer a file directly to an embroidery software
(e.g. Stitch & Sew), select the file from the directory box and press
the “Transfer”
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button from the toolbar
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or the “Read” button

from the toolbar

Write Card
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The Write Card option enables you to write design files to any
rewriteable embroidery cards, regardless of the file format that
you choose. After that, you can mount the card to your embroidery
machine and sew those designs. You can also write design files
to other storage media such as floppy disks and SmartMedia cards.
When you select the Write Card option, the corresponding window,
like the one shown below, comes up.

The Write Card window consists of the main toolbar, the file catalog,
the directory & info box, the preview box, the Send To, Write
and Close buttons and the status bar.
| User’s Guide | Write Card 

Main toolbar

Add: The “Add” button opens a new window, where you can
select design files to write to the card
Delete: By pressing the “Delete” button, you delete the
selected file from the list
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The main toolbar contains all the functions related to writing design
files to any type of rewritable embroidery cards, and other storage
media like floppy disks and SmartMedia cards.

You can add design files regardless
of their file format; they will be written
and recognized by the card

Delete All: If you select the “Delete All” option, all the files
included will be delete from the file list
Size: By pressing the “Size” button, you receive information
about the remaining space of the inserted card, and the
number of stitches contained in the patterns
Properties: It shows information on the selected design,
and it enables the user to save it in different formats
Graphics: This option opens up a new window where all the
designs included in the catalog are shown as images
Catalog: The Catalog option creates a catalog of all the
designs included in the directory, in an HTML format
Print: It prints a screenshot of the screen shown currently
Clip: This option makes a clip of the catalog of files
for Notepad
Send To: By pressing this button, a new window comes up
where you can choose the type of storage media where
you want the design files to be saved
Write: It writes all the files included in the file catalog, into
the card
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You can only insert one card at a time
to the Multi-Converter. Otherwise the
device will not be able to write the files
to any card

File Catalog
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If you have not selected any files to be
added, the file catalog will be in yellow
color, meaning that you have to add files
to it in order to proceed.

The file catalog contains all the files selected by the user in order
to be written to a rewritable embroidery card or another storage
media.
Directory & Info Box

This box shows the directory from where you select the design files
in order to be written to a card or another storage media. It also
shows the type of the inserted card. Finally, you can select the type
of embroidery machine that you use, so that the written files will
be readable by your machine.
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Preview Box

The preview box shows a preview of the selected design file.
The image is in black & white, just enough to give you a clue
of what the design is about.
Send To, Write and Close buttons

Although the “Send To”, the “Write Card” the “Close” options
are already available on the toolbar and on the top right corner
of the window, these buttons exist for reasons of ease of use.
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If there are no design files selected in the
file catalog, the “Send To” and the “Write”
buttons will be hatched. This means that
a preceding action must be done in order
these buttons to be activated.

Status Bar
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The status bar shows the progress in the process of writing
to an embroidery card. This bar shows information only when
card writing is in progress.
How to write designs to an embroidery card or other
storage media
1. With the device plugged into your computer, start the MultiConverter utility
2. Insert the card that you want to write to, into the corresponding
slot. Each slot writes to specific types of embroidery cards:
Slot A : Singer (XL-100, XL-1000)
Slot B : Pfaff, Bernina Artista, Fairyland
Slot C : Janome, Elna, New Home, Kenmore
Slot D : Brother, Bernina Deco, Babylock, Husqvarna, Viking
3. Press the “Write Card” from the main menu

4. Press the “Add” button
in order to select the design
files that you want to write to the embroidery card or to other
storage media
You can select design files of different
formats at the same time (.xxx, .dst etc.).
They will be written in the card and they
will be readable by the embroidery machine without any problems

5. In the window that comes up you can select the directory and
the files you want to write to the embroidery card or the other
storage media. There is also a preview box so that you can view
the designs before you choose
| User’s Guide | Write Card 
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6. If you want to delete a file from the ones you added to your
catalog, select the file and press the “Delete” button
.
If you want to delete all the files you added to your catalog press
the “Delete All” button
If you want to write to a rewritable embroidery card:
7a. When you finish adding design files, select the type of the em
broidery machine where you will use the card

8a. Then, press the “Write” button from the toolbar
on the low right corner of the window
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or the one

If the rewritable embroidery card that you
inserted in the Multi-Converter device
contains design files already, those files
will be overwritten.

If you want to write to other storage media:
7b. Press the “Send To” button from the toolbar
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on the low right corner of the window
window will come up:

or the one
. The following

8b. From the menu above, select the type of media you want
to write the files in.

The first option “Backup to removable
storage” will backup to any removable device is specified in the Settings e.g. floppy
disk or SmartMedia
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The Erase Card option gives a user the ability to delete the contents
of a rewritable embroidery card, in order to be able to write
different designs to it. When the “Erase Card” button is pressed,
the utility asks the user to insert the card.

When you insert an embroidery card and press OK, the utility
double-checks if you want to erase the embroidery card by showing
the message above.

If you press OK the erasing process starts, as it is indicated
in the status bar. When the operation completes the following
message appears.

 | User’s Guide | Erase Card
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Erase Card

If you insert for deletion an embroidery card which is
not rewritable or it is protected, the utility will not attempt to erase it and the following message will appear.
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Card Information

In this window you get general information about the card,
the name of the project, the card version, the date, the card type
and the indication if the card is Protected or Rewritable.
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The Card Information option provides useful information
for the embroidery card that you insert in the Multi-Converter
device. When you insert a card and press the “Card Information”
button, the device analyses the card and the following window
comes up.

If the Card Type box shows the capacity
of the card and not its type, it means that
this card is not rewritable.

The Clip button makes all the information of the above
window a clip for Notepad.
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You can change the embroidery card and insert
a different one when you are inside the Card Information dialog.
By pressing the Refresh button, the device reads and presents
the information of the newly inserted card.
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The Settings section of the Multi-Converter utility is where
you define and your preferences and properties for the best use
of the Multi-Converter. This section is divided to four sub-sections.
These are the “Hardware”, “Hoops”, “Colors” and “Options” sections.
In all of them, there is the “Associate” button which is an important
part of the utility. Also, there is the “User” filed where the user can
state his username. On the following part of this manual, there
is a brief description for each of these sub-sections.
Hardware

 | User’s Guide | Settings
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Settings

In the “Hardware” section you can set the Serial Port settings,
together with the Port Type, and also define a floppy disk drive.
If you are unaware of the Serial Port settings and the Port Type
you use, you can do an automatic search by pressing the “Search”
button
.
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By pressing the “Search” button a new window comes up, where
you can ask for an automatic search for the port settings by pressing
the “Auto” or the “Find” button. When these are found, you can
press “Apply” to save these settings.
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Hoops

In the “Hoops” section you can set the hoop size that you use.
On the left part of the window shown above, you can select the
type of home embroidery machine that you use. On the right part
of the screen, the available hoop sizes for this type of embroidery
machine show up. From there, you can set the hoop size that you
want to use for your designs. After you have set the hoop size,
the utility will not allow a design bigger than the hoop to be written
to an embroidery card, in order to help you avoid sewing errors and
needle breaks.
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Colors
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In the “Colors” section there are three options that you can define.
The first one is the type of drawing pen that will be used to draw
the preview images of the design files. It can be set to Dot, Cross,
Square, Vertical, Horizontal and Diagonal.
The second one is the default colors that you will use. By pressing
the “Default Colors” button
, the Windows
Color Palette comes up from where you can define custom colors.
The third one is the background color that you want to use.
By pressing the “Background Colors” button
,
the Windows Color Palette comes up once more and you can
choose the background color that you want.
| User’s Guide | Settings 
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Options

The “Options” section contains miscellaneous options that are
not related to the previous sections.
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On the left part of the window there are the options below:
Show Print Dialog: Tick this if you want the Print Dialog to appear
whenever you press the “Print” button.
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Show Jumps: Tick this if you want the jump stitches to be visible
in the bitmap images of the design files.
Diagnostic: This option is useful when you have a card that seems
to be un-readable or un-writable. If you tick this, you may notice
that in the “Card Information” section there is an “Identify” button
now. By pressing this button, a card.tmp file is created inside the
Multi-Converter utility folder. This file contains information about
the card by which the developer of the device can define the cause
of the cards not working.
Close after Transfer: By ticking this, each time you select to
transfer a design file to Stitch & Sew (by pressing the “Transfer”
button from the Read Card window), the Read Card window will
close automatically.
Show Catalog: Tick this option if you want a catalog of the files
existing in the card to be shown each time you read a card.
On the right part of the window you can select the language that
you want to use.
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Associate

As it was mentioned earlier, the “Associate” button
is available in all the sub-sections of the “Settings” button. This is
why it is an important part of the utility. This is where you set which
program will be associated with each embroidery file type.
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By selecting a file type from the list shown above, you can select
if you want this file type to be associated with the Stitch & Sew
program or the Multi-Converter’s own utility. This means that if
for example you select the PEC format to be associated with
Stitch & Sew, each time you press the “Transfer” button from
the Read Card with a PEC file selected, this file will be automatically
transferred to the Stitch & Sew program.
You may notice that in the list above, there is an “ALL – All MultiConverter formats” option. If you select this, you can associate all
the embroidery file formats to the program that you will select.
In the File Type Details you can set any embroidery software you
want the selected file type to be associated with. Like shown in
the screenshot below, you can set the file path of the embroidery
software by pressing the “Browse” button
the selection by pressing the “Clear” button

, or clear
.

Finally, you can set the file path of the Stitch & Sew utility
by pressing the “Browse” button, in the section shown below.
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Although the Multi-Converter device works as a standalone as well,
it is generally recommended to use it in collaboration with the
Stitch & Sew software, a unique software designed especially for the
Home Embroidery user.” Therefore, you can set all the file formats
which are readable by Stitch & Sew to associate with this program,
as it is mentioned in the paragraph above.
The advantage you get when associating with Stitch & Sew is that
you can start the Multi-Converter utility directly from Stitch & Sew
and send the files that you want to be written to an embroidery
card or other storage media.
When you open a design (or designs) in Stitch & Sew and you want
to write it to an embroidery card, you simply select the “Send to
Multi-Converter Utility” option that exists in the File menu.
In Stitch & Sew, go to File and select “Send to Multi-Converter Utility”.
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Tip!
Ask your local dealer for further information
on the ‘Stitch & Sew’ software or check out
it’s website at www.stitch-sew.com
to find out more about the capabilities
and advanced functionality of this very
special software !
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Multi-Converter and Stitch & Sew

A new window will open, where you will be able to select the file
or files you want to write to an embroidery card with the MultiConverter utility.
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When you select the files you want and press OK, the MultiConverter utility will start automatically and the selected files will
be added to the Write To catalog as shown below.
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Design Properties
On the toolbar of both “Read Card” and “Write Card” windows,
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there is a button called “Properties”
. By pressing it, you enter
the properties of the selected design file. A new window like
the one below comes up.

Inside the “Design Properties” window you can see the path of
the selected file, a preview of the design, design area information,
number of stitches, colors, stops and changes, and thread colors.
If the design is a multi-hoop design, each hoop will be previewed
in a different box (the small ones on the top of the window).
By pressing the “Print” button you can print a screenshot
of the whole window.
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The “Set Area” button is only useful for Brother which
has this functionality for positioning designs. For example, suppose
you have a 4*4 design and you want that in the corner. Given your
hoop is 10*10, you claim the design is 10*10. Now you can move
the design around in the Brother software and position it anywhere.
Once you’re happy with its position, you save it. However, you
cannot move the design as you fixed it by saying it is 10*10 and not
4*4 as the real design is. Set Area gets rid of the 10*10 and makes
the design 4*4 again and now you are able to put it where you like
it as you can move the design around in the 10*10 hoop which was
earlier not possible.
The “XXX file” button, converts the selected design file
automatically in XXX format. This is helpful for design files which
are not readable by Stitch & Sew. By using this button you are able
to transfer these files directly to Stitch & Sew, and work without
any problems.
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The “Previous” and “Next” buttons move
you from one design file to another.

Button and dialog box conditions
Buttons and dialog boxes inside the Multi-Converter utility can be
seen in different conditions in different occasions.
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As you may notice in the above window, the file catalog is in yellow
color, the “Send To” and the “Write” buttons are hatched, while
the “Close” button is active (it can be pressed).
In this occasion, no files are currently selected for writing to an embroidery card or other storage media. This is why the “Send To”
and “Write” buttons are hatched. The yellow color on the file
catalog indicates that in order these buttons to become active,
you need to add file to the file catalog. If you add files to the
catalog, then it becomes white and the buttons become active,
like in the screenshot below.
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Buttons can be met in another condition as well. In the screenshot
below, you may notice that the “Erase Card” and the “Card Information” buttons are grayed, meaning that they are inactive (they
can not be pressed). This occurs when the Multi-Converter device
is not connected on the computer, and therefore no cards can be
erased or examined.
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The Help Menu in the Multi-Converter utility provides useful information and tips about the Multi-Converter and its features.
It consists of three buttons as it is shown below.

In the “Contents” section you can find all the contents that exist in
the help file of the utility. Therefore, you can look up help topics
that interest you and read about them.
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Help Menu

The “Using Help” section provides the option of using a search
engine to look for specific topics in the help file.
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Finally, the “About Multi-Converter…” section provides information
about the utility, like the version number and the current Windows
version installed.
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